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What's the problem?
This paper is a description of how to recover data from a machine that, for some reason, 
will no longer boot into its normal operating system (typically a Windows of some form). 
There are limitations to the technique, but it will cope with data on a system that has one 
of:

1. A version of Windows has been overrun by a virus, or other malware, so it is not safe or 
even practical to boot Windows again.

2. An old machine that has failed during some operation and can no longer be updated to 
fix the problem.

3. A machine where this system disk has failed, but a data disk is still usable. (In this case, 
remove the system disk first, before applying this paper.)

But it cannot recover from disks that have failed, of where the file system has been 
corrupted too much. A minor corruption may still allow a certain amount of data to be 
recovered this way – it is certainly worth trying.

What is a Live CD?
By a Live CD, I mean a CD that contains a complete operating system (OS). A PC can 
boot from CD and so it can load and run this OS. But the OS will not write to any of the 
hard disk user file systems unless requested to by the user. So there is no danger of losing 
any of the data that is there, and in fact, these OS's will run even if there is no usable disk 
at all. Typically, they run a version of Linux. I will consider just two here; Ubuntu and 
Puppy.

Ubuntu is a large fully functioned OS and set of applications. The CD contains 700MB of 
data, and has enough intelligence built in to discover for itself almost everything it needs 
as it begins to execute. It can determine what sort of display is present, and other devices, 
with minimal interaction with the user. But it is very large, and is not suitable for machines 
with little memory.

Puppy is a much slimmer OS (about 95MB) and runs quickly, with much less function in its 
standard applications. It needs more help to tune the display, and make network 
connections, but it can run on old and slow machines.

Basic process
Before you need it, go to your preferred site and download the Live CD contents as a 
single .iso file. This is then burnt onto a CD. Note that you must do this not as a file in a 
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project in your CD writer software, but the .iso file is an exact image of the CD that is to be 
made. Your software should give you the option of burning an image. Most of the websites 
where you download these files will also have instructions on how to make the CD.

If you have not got one when you need it, get someone else to download and burn one for 
you.

When you need to recover your data, boot with the Live CD, mount the file systems you 
want to access, and copy the data onto a memory stick or removable disk attached via 
USB. I will not attempt to describe copying onto a writable CD, as that is a more complex 
matter.

Puppy Linux
You can get Puppy Linux from http://www.puppylinux.org/ and follow the instructions. The 
version I will be describing is 4.1, the latest official one at the time of writing. It is 94MB in 
size, but the CD must consist of exactly just that data.

Booting

If you cannot get the machine to boot, how do get the CD drive open? If you look carefully 
at the front of the drive door, you should see somewhere on it a tiny hole, just large 
enough to take a stiff paperclip when it is uncoiled. Use said paperclip to push gently into 
the hole, and you should find the door will spring open. Pull it out, insert the CD and close 
it.

Then power up the machine and it will probably boot from the CD. If it does not, then you 
will have to change the order of search for the boot disk in the BIOS. See your instruction 
booklet for the machine, or note carefully the screen as it comes up and see if there is a 
function key (often F2) to hit to get into the BIOS. As all machines seem to do this slightly 
differently, I cannot give further help here.

The screens and questions

Puppy will ask a number of questions. The first screen will almost certainly default to 
something sensible after 5 seconds, so let it time out and continue.

Keyboard layout

Use the down arrow to scroll down the list to highlight "uk qwerty(uk)". If you have a 
Dvorak keyboard, you'll be out of luck with Puppy – the best thing is to switch to a qwerty 
keyboard. Then hit enter to continue.

Xorg or Vesa?

Xorg is a powerful display management and windowing system, but needs to be carefully 
tuned or it may not show anything at all. Since all we are interested in doing is recovering 
data, then I recommend using the Vesa option (use Tab or right arrow to select it, as it 
says). It does everything we want and is much less likely to cause problems.
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Video wizard

This is the opportunity to set the screen resolution to a suitable value. It will default to a 
small screen, but modern displays will have no trouble with choosing 1024x768x16 and it 
will give you more space on the display to see the file systems when moving data around.

In any case, remember the key combination CTL-ALT-BACKSPACE, which when 
depressed simultaneously will abort the windowing system and allow different settings to 
be used instead.

Puppy has booted

The desktop will look vaguely similar to what you are used to, with a picture of snowy 
mountains, blue skies and a bit of cloud. Along the bottom of the desktop you will see 
appearing icons for the various file systems it can find. If you let the mouse hover over an 
icon it will tell you which file system it is, and the one you probably want is something like 
"ntfs", but it will depend on how the system was set up.

If you click on the icon, a green spot will appear on it, and that means the device can be 
accessed. In a little while, a window will appear showing its contents.

You can now navigate in an obvious way to the files that you want. You may not be able to 
read what is in all the files, but you can see what they are by name.

Copying to a USB memory stick (or external disk)

You can now plug your stick or device into your USB port, and another icon will appear 
showing the new device it has found. Clicking on it will open up another window where you 
can browse through the contents, and clear space if you need to. (Right click on a file icon 
will give you a useful list of options).

When you are ready, you can now drag and drop files and directories from one window to 
the other. It will ask what you want to do, and make sure you use Copy (not Move) to 
ensure that no changes are made to the old file systems.

A peculiarity of Linux file access is that the copy will buffer the transfer. This means it will 
not be complete when it apparently says it is, but if you wait, you may find that the light on 
the stick or device continues to flicker for some time afterwards. This is normal, and do not 
remove the device at this point, or close the system down.

Instead, when the flickering stops, close the file browser windows, and right click on the 
device icons which show a green spot. Select "Unmount", and wait until the green spot 
vanishes. Then you can disconnect the device.

Close down

When you've transferred all the data, close Puppy down by clicking on the button in the far 
bottom left, and selecting what you want. When asked about saving your data, it is best in 
this case to select "Don't Save" as there may be no safe place to save the temporary data.

And you are done. Now put the data where you want it.
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Ubuntu
This is a popular version of Linux, but is large. The download can be found at 
http://www.ubuntu.com/getubuntu/download and follow the instructions. It is large – very 
nearly 700MB in size. The CD must be burnt from the image that is downloaded, so do not 
attempt to burn it as a file in a project. Your CD writing software should give you the option 
of using the .iso file as an image to burn the CD.

Booting

If you cannot get the machine to boot, how do get the CD drive open? If you look carefully 
at the front of the drive door, you should see somewhere on it a tiny hole, just large 
enough to take a stiff paperclip when it is uncoiled. Use said paperclip to push gently into 
the hole, and you should find the door will spring open. Pull it out, insert the CD and close 
it.

Then power up the machine and it will probably boot from the CD. If it does not, then you 
will have to change the order of search for the boot disk in the BIOS. See your instruction 
booklet for the machine, or note carefully the screen as it comes up and see if there is a 
function key (often F2) to hit to get into the BIOS. As all machines seem to do this slightly 
differently, I cannot give further help here.

Questions and screens

The first question it will ask is the language you speak. It will default to English if you do 
nothing after 30 seconds, or you can hit the Enter key to speed things up.

When the menu is clearly visible, you will need to change the keyboard map from the US 
to UK layout. To do this, hit F3, highlight UK using the Up arrow key and hit Enter. This will 
be for the usual qwerty layout; Dvorak does not seem to be supported at this level.

The first item on the menu now shown is to boot without changing your machine. This is 
highlighted in white; hit Enter to start the booting process.

Ubuntu has booted

If all goes well, it will take several minutes to locate and identify all the hardware, and 
finally boot into Ubuntu. The screen will then appear with a distinctive brownish 
background, and toolbars along the top and bottom of the screen. This may not look like 
Windows to you, but the principles are the same as you will discover.

Finding the file systems

At the top of screen on the left, you will see a Menu heading Places. Click on that and 
halfway down the list it will show all the file systems it can find. Click on any one of them to 
bring up the file browser, which will have in its left hand column all the directories it can 
find. Clicking on them will show you their contents. there may be a short delay for some, 
but that is because it has to prepare them for access ("mount" them in Linux terminology).

Navigation through the system is then just like any other file browser, and so find the files 
and directories you want to recover.
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Copying files

You can now insert your memory stick, or USB hardware device, and after a short delay, a 
new browser window will appear showing the contents of the stick. You can now clear any 
space you may need to from it before copying the files.

Highlight the files you wish to save, and Edit -> Copy (or Ctrl-C) will remember them for 
pasting. Then go to the stick window, and Edit -> Paste (or Ctrl-V) will copy them over to it.

A peculiarity of Linux file access is that the copy will buffer the transfer. This means it will 
not be complete when it apparently says it is, but if you wait, you may find that the light on 
the stick or device continues to flicker for some time afterwards. This is normal, and do not 
remove the device at this point, or close the system down.

To ensure it is safe to remove the memory stick, in the stick window, File -> Unmount will 
flush all the data onto the stick and release it. You can then remove it safely, although I 
would always close the window as well first.

You can then close all the file browser windows. For each device icon that has appeared 
on the desktop, you can right-click and unmount them. When they have all gone, you can 
close down.

Closing Down

The close down button is found at the top right of the screen in red and white, looking like 
an on-off symbol found on electric appliances. Click and select the type of activity.

Before you go
If you do not know Linux, before you close down, why not spend a bit of time 
experimenting with the system to see what it can do. Bear in mind that Puppy is a very 
simple system and has a lot of things missing, although is very useful in our case here. But 
Ubuntu is fully featured and can give you an idea of what is available by looking at all the 
applications found from the top left of the screen. It will seem slow at times because it is 
running off the CD, and not off the hard drive which would make it considerably faster.
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